Creating a Facility License

Note: You must have an assignment to the provider record to create a Facility License for the
provider.

Provider (7
1. From your desktop, select the Create Provider Work icon. This will open the
Create Provider Work page.
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2. From the License drop-down, select Facility License. Select the appropriate provider and
click Create.

/2 Create Provider Work - Microsoft Internet Explorer provided by DHFS - State of Wisconsin
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3. Select the appropriate Class. If applicable, add the Other License(s) and Specialty Programs /
Services Offered / Target Groups by clicking the appropriate Insert button.

/= Facility License - Microsoft Internet Explorer provided by DHFS - State of Wisconsin

Print (i Spell Check .,

— Provider
Provider Mame: ABC Shefter Care (5221785) Licensor: Conn C. Corn, Jr.
Type: Shelter Care Clazs: ISmaII ;I

Provider ormation i E Complaints
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Primary Contact:

Cio:

Address; 2415 E Washington Suite 200 Apt
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4. Click on the License Information tab. In the Application Activity group box, click the Insert

button. This will open the License Information page.

/= Facility License - Microsoft Internet Explorer provided by DHFS - State of Wisconsin

Print (i
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Provider Name: ABC Shelter Care (92217835} Licenzsor:
Type: Shelter Care Clazs:

Conn C. Corn, Jr.
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License Information
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5. Enter the applicable dates: Materials Sent to Licensee, Application Materials Received, 2™
Notification to Licensee, and 3" Notification to Licensee.

9‘ License Information -- Webpage Dialog

e WiSACWIS ™ (" print (@  SpeiCheck(/ Hep (9
— Provider
Provider Name: ABC Shelter Care (5221765} Licensor: Conn C. Corn, Jr. Search - Completed
Type: Shelter Care Status: Pending

— Application Activity

Materials Sent to Licenses: IDWDWUUUD Applicatien Materials Received: IDWDWUUUU
2nd Notification to Licensee: IDWDWUUUD 3rd Notification to Licensee: IDWDWUUUU
Decision: I Pending 'I Decizion Date: IDU-J’U-EHDDDD

—License

J

Operated for Proft:. @

Effective From: IDDJ’DD!DDDD Owner Type: I LI

License Type:

Effective To: IDD!DD!DDDD Capacity: 30 Gender:  Wale Age Range: 13t0 18
Renewal Sent: IDD!DD!DDDD Sponsor: I
Amount Due:

Specialized Program(s) (select all that apply): Respite ™ Second Chance Home [T ShortTerm [T Typez I

Options; LI

]
&

Close
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6. Select the appropriate Decision. To license the provider, select Create License and enter the
Decision Date.

Note: If the Licensor is different than the primary licensor assigned to the provider record,
click the Search hyperlink next to the Licensor field and search for the appropriate
licensor.

g License Information -- Webpage Dialog

rro 44 PP ! e .
e WiSACWIS ™ et (@  speicheck! / Hep (@
— Provider
Provider Name: ABC Shelter Care (5221765} Licensor: Conn C. Corn, Jr. Search r Completed
Type: Shelter Care Status: Pending
— Application Activity
Materials Sent to Licenses: IUUfUUfUUUU Application Materials Received: ID‘JI‘ZSI‘ZU’I o
2nd Notification to Licensee: IUUfUUfUUUU 3rd Notification to Licensee: IUUfUUfUUUU
Decision: I Create License 'I Decizion Date: |1ur11rzu1u
— License
License Type: I 1=t Probationary vl Operated for Proft:. @
Effective From: 10/15/2010 Owner Type: I Corporation/Profit ;I
Effective To: 03/31/2011 Capacity: 30 Gender:  Wale Age Range: 13t0 18
Renewal Sent: IDD.-'DD.-'I.'II.'IL'ID Sponsor: I
Amount Due: 2151.25
Specialized Program(s) (select all that apply): Respite [ Second Chance Home [ Short-Term [T Type2 [

7. Inthe License group box, enter the license information. When you select the Effective From
Date, the system automatically determines the Effective To date (1* Probationary and 2"
Probationary license are effective for 6 months and a Regular license is effective for 2
years). If the Effective To date should be less than the system determined date, update the
Effective To date. Select the Owner Type. Enter the Sponsor, if applicable. Select any
Specialized Program(s), if applicable.

Note: The Operated for Profit, Capacity, Gender, and Age Range are pre-filled from the
Private Provider page. To change any of these fields, click on the blue hyperlink in
the Provider group box at the top of the page [in this example: ABC Shelter Care

(9221765)].
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Note: The Amount Due field will also pre-fill. This amount is determined based on the type
of provider license and the associate capacity. When the license is complete, it will
enter a row (License Fee Due) on the Fees tab of the Facility License page.
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8. When all applicable data has been completed, click Save. Under the Options drop-down,
select the Facility License option and click Go to create the license template.

3 License Information -- Webpage Dialog

e WiSACWIS ™ (" print (@  SpeiCheck(/ Hep (9
— Provider
Provider Name: ABC Shelter Care (5221765} Licensor: Conn C. Corn, Jr. Search r Completed
Type: Shelter Care Status: Pending

— Application Activity

Materials Sent to Licenses: IDWDWUUUD Application Materials Received: Imm
2nd Notification to Licensee: IDWDWUUUD 3rd Notification to Licensee: IDWDWUUUU
Decision: I Create License 'I Decizion Date: 10M11/2010

— License
License Type: I 1=t Probationary - I Operated for Proft:. @
Effective From: 10/15/2010 Owner Type: I Corporation/Profit ;I
Effective To: Iﬂl’ﬁ'l 12011 Capacity: 30 Gender:  Wale Age Range: 13t0 18
Renewal Sent: IDD!DD!DDDD Sponsor: I
Amount Due: 2151.25

Specialized Program(s) (select all that apply): Respite [ Second Chance Home [ Short-Term [T Type2 [

Text

App and Fee Payment for Regular 2-vr License
Fee Payment and/or Application
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9. On the template, select the appropriate type of license (Child Placing Agency, Shelter Care
Facility, Residential Care Center, or Group Home). Select the appropriate license type, if

applicable (Probationary, Second Probationary). Select the appropriate license to operate
(Child Placing Agency, Shelter Care Facility, Residential Care Center for Children and

Youth, or Group Home).

Note: There is also an option to select ‘Amended’ or ‘Expiration Date’ (located directly

below the “Original License Date”) and an associated field to enter any applicable

data.

“El 50000004,0.0tF - Microsoft Word
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Type a guestion for help
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- THE STATE OF WISCONSIN = #

DEPARTMENT OF CHILDREN AND FAMILIES

- DIVISION OF SAFETY AND PERMANENCE

: CHILD PLACING AGENCY

- PROBATIONARY LICENSE

g ABC Shelter Care

2415 E Washington

: Milwaukee, WI 53203

" is licensed to operate a

: Child Placing Agency known as

: ABC Shelter Care

N 2415 E Washington

: Milwaukee, WI 53203

. Maximum Capacity: 30

. Ages of Children Served: 13 through 18

- Gender of Children Served:  NMale

7 Specialized Programs:

:- ORIGINAL LICENSE DATE: 10/15/2010 Eloise Anderson Secretar

: E3 DEPARTMENT CF CHILDREN AND FAWILIES

- To determine the current status of this license or to

) This license 1s effective unless revoked, suspended or voluntarily surrendered. file a complaint regarding this facility, please contact:

_ The Letter of Transtnittal 1z incorporated herein. Any and all exceptions and

- stipulations or conditions to this license shall be posted near the license Bureau of Permanence and Out-of-Home Care

- certificate Child Welfare Licensing Section

o This T . ¢ wader the nertinent £ e ction 45,60 through 201 ]?last Washington Avenue, E200

: 4 %l;f%?slgnixsﬂﬁtgtamEEsf £ Pertment provisions o £ Chon . oug] Malilsﬂﬂ, W1 53703

(608) 267-7932
- DCFF-CFSITUE (R, UT/201T) -
f :
= HE K] [ ’
Page 1 Sec 1 11 AL 58 Ln24 Col L REC TRE EXT ove (O 4
10. When you are finished with entering information on the template, print the template by
selecting File > Print. After you have printed to license, click the Close and Return to
eWISACWIS button to return to the License Information page.
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11. Click the Save button. When all information has been complete and you are ready to
officially license the facility, click the Completed checkbox on the top right and then click
Save.

a License Information -- Webpage Dialog

e WiSACWIS ™ (et (@  spencheck! / Hep (P
— Provider
Provider Name: ABC Shelter Care (9221765} Licensor: Conn C. Corn, Jr. Search
Type: Shelter Care Status: Pending

— Application Activity

Materialz Sent to Licensee: IDEI-J’D-EH[I[I[ID Application Materials Received: Iﬂ&?&?ﬂm
2nd Motification to Licensee: IDU-J’U-EHDDDD 3rd Notification to Licensee: IDU-J’U-EHDDDD
Decision: I Create License vl Decizion Date: 10112010

—License
License Type: I 1st Probationary VI Operated for Profit: F
Effective From: 10152010 Owner Type: I Corporation/Pro fit j
Effective To: 03312011 Capacity: 30 Gender:  Male Age Range: 1310 18
Renewal Sent: IDDJ’DD!DDDD Spensor: I
Amount Due: 5151.25

Specialized Program(s) (select all that apply): Respite [T Second Chance Home [ Short-Term [T Typez [T

Optiens: I Facility Licenze LI Save

12. Click the Close button to return to the Facility License page.
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13. The new license has now been added to the License Information group box at the bottom of
the page. To view the license, click the blue hyperlink (1st Probationary in this example) in
the Type column to open the License Information page.

/2 Facility License - Microsoft Internet Explorer provided by DHFS - State of Wisconsin

e WiSACWIS Prit (@  SpellCheck |/  Help (P
— Provider
Provider Name: ABC Shelter Care (9221765} Licensor: Conn C. Corn, Jr.
Type: Shelter Care Clazs: ISmaII LI

Provider License Information Site Visits Enforcements Complaints

— Application Activity =
Materials Sentto Licensee Application Materials Received Decision Date

— License Information

Type Status Effective From w Effective To Capacity Age Range Gender Licensor
1=t Probationary Active 104152010 033172011 30 13to 18 Male Conn C. Corn, Jr.

-

Close

Installing components. ., l_ l_ I_ I_ I_ l_ |g Local intranet |~fa - | H105% - S
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14. 1t should be noted that the license can remain pending. On the License Information page, do
not select the Completed checkbox. You can then access the pending application/license in
the Application Activity group box by clicking on the hyperlink for the Decision:

//159.158.38.79/ - Facility License - Microsoft Internet Explorer provided by DHFS - State of Wisconsin

L o Y Y : ARG
e WiSACWIS print (@ Spencheck [/ Hep (P
— Provider
Provider Name: ABC Shelter Care (S0000000) Licensor: Wichael Kemp
Type: Shelter Care Clazs: I Famihy LI
Provider License Information Site Visits Enforcements Complaints

— Application Activity =

Materiale Sent to Licenses Application Materiale Received Decision Date w

09/08/2010 Create Licenze 10272010

— License Information

Type Status Effective From Effective To Capacity Age Range Gender Licensor

-

Close

[trstaling companents. .. [ [ T [ [ [ trusted sites [va - [®H 5% ~ 4
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Creating a Continuation License

1. From your desktop, click on the Providers expando and locate the provider for which you are
creating a continuation license.

2. Click on the Provider icon & to display a list of work for the provider.

3. Click on the Licenses icon to display a list of licenses for the provider.
4. Click the Facility License hyperlink for the Active license.

cWisSACWIS

Create  Maintain  Utlities  Adoption Search - Help

Jenny Weber's Desktop

[+ Date Restricted [~ ParticipantView [~ View Mot Approved/Cancelled

b Ticklers

b Cases (0}
¥ Providers (8)

@ ABC Shelter Care (8037344) Actions
Shelter Care 04M2/2011 Kemp, Michael Mihwaukee
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Licenses
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5. The Facility License page opens. Click on the License Information tab.

e Wis.

print (d

Spell Check {7

Help if'?

— Provider

Provider Name:

Type:

ABC Shefter Care (S0000000)

Shetter Care

Licensor:

Michael Kemp

Class: | Farnily

Provider

— Physical Address
Primary Contact;
Cid:

Address:
City:
Phone:

Email:

nformation

Com | aﬂi

2415 E Washington
Wilwaukes
Ext:

Apt
State: Wl

Fax:

Zip: 53203

County of Residence: Milwaukee

— Other License(s) — Specialty Programs | Services Offered | Target Groups
Other License(s) Program/Senvice/Group.
April 2011
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6.
Information page.

c WiSACWIS

print (&

In the Application Activity group box, click the Insert button. This will open the License

Help ir?

Spel Check {7

— Provider
Provider Name:

ABC Shelter Care (50000000}

Type: Shelter Care

Licensor; Michael Kemp

Class: | Famiy

=l

Provider

— Application Activity

License Information BEs

Site Misits Enforcements

Complaints

[»

— License Information

Type Status  EffectiveFromw  EffectiveTo  Capacity ~ AgeRange  Gender  Licensor
1=t Probationary Active 1052010 03/31/2011 30 13to 18 Male Michael Kemp

April 2011
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7. The License Information page opens with the Decision defaulting to Pending. Select the
appropriate License Type.

9 License Information -- Webpage Dialog

— " s
e WiSACWIS ™ ( pint (@ spelicheck !/ Help@
— Provider
Provider Name: ABC Shelter Care (9221785} Licensor: Conn C. Corn, Jr. Search - Completed
Type: Shelter Care Status: Pending
— Application Activity
Materials Sent to Licensee: IUUIUUIDDDU Application Materials Received: IUUIUUIDDDD
2nd Motification to Licensee: IUU!UUIDDDU 3rd Notification to Licensee: IUU!UU!DDDD
Decision: I Pending vl Decizion Date: IDD!DD!L‘IL‘IL‘ID
—License
License Type: I Regular vl Operated for Proft: @
Effective From: ID-‘-.-'D'IIEIJH Owner Type: I LI
Effective To: IUE.-'E'IIZI]‘IB Capacity: 30 Gender:  Male Age Range: 13to 18
Renewal Sent: IDD.-'DD.-'DDDD Sponsor: I
Amount Due: 5605
Specialized Program(s) (select all that apply): Respite [T Second Chance Home I Short-Term [T Type2 T

Note: The Effective From date is pre-filled with the date one day after the Effective To date
on the Active license. The Effective To date pre-fills with six months for a 2™
Probationary License and two years for a Regular license. These dates can be
updated.

Note: The Operated for Profit, Capacity, Gender, and Age Range are pre-filled from the
Private Provider page. To change any of these fields, click on the blue hyperlink in
the Provider group box at the top of the page [in this example: ABC Shelter Care

(9221765)].

Note: The Amount Due field also pre-fills. This amount is determined based on the type of
provider license and the associate capacity. This fee can change if the license type,
capacity, or provider type changes during the licensing process.
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8. When all applicable data has been completed, under the Options drop-down, select one of
the continuation letters (App and Fee Payment for Regular 2-Yr License, Fee Payment
and/or Application, License Continuation Process, Past Due Application Materials, or
Probationary License Expiring) and click Go to create the appropriate letter.

0 9233028.0.1tf - Microsoft Word =] x|
‘W] Fle  Wiew  Window Typeaquestionforhelp  ~ - @ X

S (A D X B @9 - ™ - EHRead 100% .!
¢ % Spell Check | "M Copy From Bookmarks | %4 Close and Return b sWISACWIS l

] [ N R RN RN E" DR s T T |

X 02/22/2011

5 Te Sam Jacobsor| 9221765

s ABC Shelter Care Shelter Care

o] 2415 E Washington Suite 300 CorporationProfit
= Milwaukee, WI 53203 Conn C. Corn, Ir
=

- Dane

From: Diane Bloecker, Licensing Chief
Division of Safety and Permanence
Bureau of Permanence and Out-of-Home Care

Re LICENSE CONTINUATION PROCESS

In order to maintain your current license, please follow the directions on the CONTINUATION PROCEDURE sheet.

ABC Shelter Care

ABC Shelter Care

2415 E Washington Suite 300
Milwaukee, WI 53203

License Continuation Date: 04/01/2011
REQUIREMENT: Continuation materials and fee(s) are due 30 days prior to the license

continuation date. Background Information Disclosure Forms and fees are due at each license
continuation.

Based on your present capacity of 30, your license fee is $605.00

License Fee: £605.00
) Caregiver Background Check Fee (510.00 per person) B
- Total Amount of the Check or Money Order: i S
- :
- Payment in the form of a check or money order should be made payable to the “Department of Children and o
T Families.” s
B E I
Page 1 Sec 1 11 At 29" Lni4 Col 13  REC TRK EXT ovR  OK

Note: The continuation letters can be generated any time during the continuation process until
the license is completed.

9. When you are finished with entering information on the template, Print the template by
selecting File > Print. After you have printed to license, click the Close and Return to
eWISACWIS button to return to the License Information page.

10. On the Facility License page, click the Save button to save the Pending license and click the
Close button to return to the Facility License page.
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11. The pending license has now been added to the Application Activity group box at the top of
the page.

R A — /  Help { ?

— Provider

Provider Name: ABC Shefter Care (8221785)

Type: Shelter Care

Licensor; Conn C. Cern, Jr.

| smai =]

Clazs:

Provider

License Information

— Application Activity

Complaints

Materialz Sent to Licenzes Application Materiale Received Decision Date -
Pending
— License Information
Type Status Effective From = Effective To Capacity Age Range Gender Licensor
1st Probationary Active 10M5/2010 033172011 30 1310 18 Male Conn C. Corn, Jr.

Installing components. ..

Close

l_l_,_|_|_|_|g Local intranet |48 ~ |_&l W=
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12. To view or to complete the license, click the blue hyperlink (Pending in this example) in the
Decision column to open the License Information page.

3 License Information -- Webpage Dialog

e WiSACWIS ™ (et (@ speicheck(/ Hep (P
— Provider
Provider Name: ABC Shelter Care (9221785} Licenzor: Conn C. Corn, Jr. Search - Completed
Type: Shelter Care Status: Pending

— Application Activity

Materials Sent to Licensee: IDEHGEHUI]I]D Application Materials Received: IDEHGEHI]I]I]U
2nd Motification to Licensee: IDU-J’U-EHDDDD 3rd Motification to Licensee: IDU-J’U-EHDDDD
Decision: I Pending vl Decizion Date: IDEHU-EHDDDD

— License

License Type: I Regular vl Operated for Proft: @
Effective From: IDr‘-«'D'h'ZIJH Owner Type: I LI

Effective To: IUE;’Z'I;'ZI]‘I 3 Capacity: 30 Gender:  Male Age Range: 13to 18
Renewal Sent: IDDJ’DD!DDDD Sponsor: I
Amount Due: 5605

Specialized Program(s) (select all that apply): Respite [T Second Chance Home [T Short-Term 7 Typez [T

Close

Options: LI Go

13. Complete the license by following the steps 5 -12 in the first section (Creating a Facility
License) of this document.
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